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Payment Transactions  

  

Gateway manages several different type of payment transaction.  



 

Payments that must be made immediately are processed using the EFT or Cheque options. It is 

also best practice to pay BPAY payments immediately.  

  

Payments to regular tradespeople or creditors are usually made by Journal and then disbursed 
as part of you mid or end of month payment runs.  

  
If a payment is not yet due but the details are to be entered into Gateway, a Pending Payment 
may be used. The Pending Payment will appear on Gateway Today on the date due for payment. 

Journals where there are insufficient funds to complete the transaction will automatically convert 

to a Pending Payment.  

  
Invoice Payments may also be linked and processed via the corresponding Maintenance task.  

                                          
        

  

MAKING A PAYMENT  
Here are some examples of payments you might make from the trust account:  

  
• Pay an owner or creditor.  

• Refund a bond to a tenant.  

• Refund a deposit.  

• Refund an overpayment of rent.  

• Settle a sale.  

  

  

MAINTENANCE INVOICES  
  

The most frequent type of payment you will make is the processing of 

maintenance invoices. These invoices may be managed via the Maintenance  

Task itself.   
When the maintenance task has been completed, an invoice received from the 

Creditor and the invoice approved for payment, the task may be marked as 

Completed and the Invoice processed for payment.  

  
1. Open the Maintenance task.  

  
Note The maintenance task may be found via Gateway Today; the Owner, Property, Tenant or 
Creditor file; or the Maintenance view.  

  
2. The subject line of the Maintenance task will become the Details line of the payment and 

will appear on the Owner’s Statement. Edit as required.  

3. Select the Completed button. A completed date and time will appear in the Completed 

fields.  

  



 

  
  

4. Select the Details tab 

5. Tick the Invoice received checkbox.  

  
a. If a quote had previously been selected, the quote details automatically populate 

the invoice fields.  

b. If No Quote was obtained then the Invoice number and Amount must be entered 

manually.  

  

  
  

6. Select Save and Close. A prompt will appear to create a payment for the Owner or create an 
Invoice for the Tenant:  

  



 

 
7. Select Create Payment for Owner and click OK - a journal payment is created for the Owner 

of the Property. If there are insufficient funds to process the journal immediately, a pending 

payment will be created. Don’t forget to attach a copy of the invoice again here so the 
owner will automatically receive a copy with their next statement.  

  

  



 

PROCESSING A CHEQUE PAYMENT  
  
Cheque payments are used to draw a physical cheque to a payee. These days, one-off EFT payments 

are more popular than cheques, however some clients still prefer to receive a cheque payment.  

  
The cheque may be hand-written, or may be either printed immediately or as a batch of printed 

cheques.  

  
NOTE Some property managers run the risk of overdrawing accounts by manually writing a cheque 

prior to checking the balances in that account. This is a dangerous habit to develop. We recommend 
that you generate the cheque on the computer first and then, while still viewing the cheque on the 
screen, write the cheque. This will reduce the risk of drawing a cheque where there are insufficient 
funds held in trust to cover it.   

  
  

1. Select Payment from the Transactions menu or Hotkey F3 - the Payment dialog box displays.  

2. Type is automatically defaulted to Cheque.  

3. The Reference number defaults to the next available cheque number and the Date defaults  

 to today's date but can be overridden if required.  

4. Enter an Invoice number. This will appear on the Statement against this transaction if this 

option has been selected in Tools, Options, Statement. If this option is not selected we 

recommend including the invoice number in the Details field.  

5. Enter the name of the person for whom you are drawing the cheque in Pay.  

6. Under the Transaction column select the ledger this payment is being made from.  

• Advertising - allows you to choose the sale you wish to take funds from.  

• Bond - allows you to choose the tenant whose bond you wish to take the funds from.  

• Creditor - allows you to choose the creditor you wish to take the funds from.  

• Deposit - allows you to choose the tenant you wish to take the funds from.  

• Owner - allows you to choose the owner you wish to take the funds from.  

• Property - allows you to choose by property which owner you wish to take the funds 

from.  

• Sale Deposit - allows you to choose the sale you wish to take the funds from. 



 

7. Enter a Description of the payment. If you are charging maintenance commission select 

more from the drop down and enter the amount, description and dissection and tick the 

box to ‘deduct maintenance commission’.  
   

 
  

8. Scan and attach a copy of the Invoice for inclusion with the Owner’s monthly statement.  

9. If the payment is being made on behalf of an Owner you must select an Expense Dissection.  

10. Enter the value of the cheque to be written.  

NOTE It is not possible to process a cheque if there are insufficient funds available on the 
ledger.  

  
11. Click OK to process the payment. 

PROCESSING AN EFT PAYMENT  
  
The EFT payment option enables you to process one-off payments to a specified bank account. Each 
EFT Payment will debit the amount from the relevant file and then create an EFT file to pay the 

amount to the recipient’s bank account.  

  
Each EFT file will include the date and time in the filename to avoid overwriting older files and thus 

enable you to send multiple files through to your bank for processing.  

  
1. Select Payment from the Transactions menu or Hotkey F3 - the Payment dialog box displays.  

2. Select a Type of EFT.  

3. The Reference number defaults to the next audit number and the Date defaults to today's  

 date.  

  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  
  



 

4. Enter an Invoice number. This will appear on the Statement against this transaction if this 

option has been selected in Tools, Options, Statement. If this option is not selected we 

recommend including the invoice number in the Details field.  

5. Enter the name of the person you are processing the EFT payment to.  

6. Under the Transaction column select the ledger this payment is being made from.  

• Advertising - allows you to choose the sale you wish to take funds from.  

• Bond - allows you to choose the tenant whose bond you wish to take the funds 
from.  

• Creditor - allows you to choose the creditor you wish to take the funds from.  

• Deposit - allows you to choose the tenant you wish to take the funds from.  

• Owner - allows you to choose the owner you wish to take the funds from.  

• Property - allows you to choose by property which owner you wish to take the 

funds from.     Sale Deposit - allows you to choose the sale you wish to take the 
funds from.  

  
7. Enter a Description of the payment. If you are charging maintenance commission select more 

from the drop down and enter the amount, description and dissection and tick the box  

  to ‘deduct maintenance commission’.  

8. Scan and attach a copy of the Invoice for inclusion with the Owner’s monthly statement.  

9. If the payment is being made on behalf of an Owner you must select an Expense Dissection.  

10. Enter the value of the payment. NOTE It is not possible to process an EFT if there are insufficient 

funds available on the ledger.  

  
11. Enter the recipient’s account details under EFT Account Details.  

12. Click OK to process the payment. 

  

  
  

    



 

PROCESSING A JOURNAL PAYMENT  
  

Journal payments are used to transfer money internally within your trust account.  

  
A journal payment is used for transferring money from a file, or a number of files, to a creditor file; 
for example, if you are not paying the creditor directly by cheque or EFT, you may use a journal 

payment to transfer money to the creditor from the owner. The owner will be debited for the 

amount and the creditor will be credited. At a later time you may process a disbursement to the 

creditor for the total monies held in their ledger accompanied by a statement showing which 

invoices have been included in this disbursement.  

  
You may link a payment to a maintenance record if the creditor's invoice details have been entered 

against the maintenance record. The payment details (for example Payee, Invoice, Amount, 

Transaction Details) will then default into the payment screen.  

  
Payment journals may only be processed to transfer funds to a Creditor's account. If you need to 

transfer funds to an account type other than Creditor, use Transactions, Journal.  

  
1. Select Payment from the Transactions menu - the Payment dialog box displays.  

2. Select Journal from the Type drop-down.  

3. The Reference number defaults to the next available journal number and the Date defaults 

to today's date but may be overridden if required.  

4. Enter an Invoice number. This will appear on the Statement against this transaction if this 

option has been selected in Tools, Options, Statement. If this option is not selected we  

  recommend including the invoice number in the Details field.  

5. Select the Creditor by typing in to the Creditor field and selecting from the list of matches. 



 

6. Under the Transaction column select the ledger this payment is being made from.  

  
• Advertising - allows you to choose the sale you wish to take funds from.  

• Bond - allows you to choose the tenant whose bond you wish to take the funds from.  

• Creditor - allows you to choose the creditor you wish to take the funds from.  

• Deposit - allows you to choose the tenant you wish to take the funds from.  

• Owner - allows you to choose the owner you wish to take the funds from.  

• Property - allows you to choose by property which owner you wish to take the funds 

from.     Sale Deposit - allows you to choose the sale you wish to take the funds from.  

  
7. Enter a Description of the payment including Invoice number, Property Address and brief 

description. If you are charging maintenance commission select more from the drop down and enter 

the amount, description and dissection and tick the box to ‘deduct maintenance commission’.  

  
8. The Creditor’s default Dissection will be selected automatically, 9.   Enter the value of the Journal 

payment.  

  
NOTE If there are insufficient funds to carry out the Journal transaction, you will be prompted 
to automatically convert the Journal to a Pending Payment.  

  
10. Click OK to process the Journal payment.  

  

 

JOURNAL TOO LS  
  

Recurrence  

Click Recurrence to set up a recurring journal payment - the Payment Recurrence 

dialog box displays.  

  
Select the Pattern for recurrence: Daily, Weekly, Monthly or Yearly and the multiplier, for 

example, 3 x months or 7 x days.  

  
If the recurrence is for a set period of time select an End by date and then click OK to return to the 

Payment dialog box.  

  



 

  
  
NOTE To remove a recurrence, click Recurrence in the Payment dialog box and then click Remove 
Recurrence.  

  
NOTE The next pending payment is created when the journal payment is processed.   You 
will receive a due date warning when processing this transaction through the payment 
screen however if processed through end of month you will not receive a warning that 
the payment is being processed prior to the due date.  

  

   
  

PROCESSING A PENDING PAYMENT  
  

When processing a creditor's invoice there may be insufficient funds in the owner's account to 

cover the invoice. Instead of keeping the invoice aside until there are sufficient funds available to 

pay them you may create a pending payment. This allows Gateway to track the invoice for you.  

  
As you receipt money into the owner's account Gateway will let you know when 

sufficient funds are available and then give you the option to process the pending 

payment at that point in time. Pending payments may also be used where invoices are 
not due to be paid until a future date. The Pending Payment will appear on Gateway 

Today on the due date entered.  

  
1. Select Payment from the Transactions menu - the Payment dialog box displays.  

2. Select Pending from the Type drop-down.  

3. The Reference number defaults to the next available journal number and the Date 
defaults to today's date but may be overridden if required.  

4. Enter an Invoice number. This will appear on the Statement against this transaction if this 

option has been selected in Tools, Options, Statement. If this option is not selected we 
recommend including the invoice number in the Details field.  

5. Select the Creditor by typing in to the Creditor field and selecting from the list of 

matches.  

6. Under the Transaction column select the ledger this payment is being made from (See 

Processing a Journal Payment).  

7. Enter a Description of the payment including Invoice number, Property Address and brief 

description. If you are charging maintenance commission select more from the drop 

down and enter the amount, description and dissection and tick the box to ‘deduct 

maintenance commission’.  



 

8. The Creditor’s default Dissection will be selected automatically, 9.   Enter the value of the 

Pending payment.  

  

  
  

Once all details have been entered, specify whether or not the funds are to be withheld 

from the owner immediately, or not until a nominated date. Select Withhold from 

owner if the funds are to be withheld from the owner (clear this check box if the funds 
are not to be withheld from the owner).  

  
Select Hold and enter the date you would like to start holding these funds in the Until 

field. Allow enough time for sufficient funds to be accumulated prior to the due date. 

Click OK to process the payment.  

  

  
    

JOURNAL (F4)  
  
A Journal is not the same as a Payment Journal. A Journal allows you to transfer money between  

different file types, for example money from/ to Owner, Creditor, Bond, Deposit or 

Sales files. This differs from a Payment Journal which may only transfer funds to a 

Creditor file.  

A Journal requires both the Debit and Credit transaction lines to be entered. It is 

possible to make multiple debit and credit entries on one Journal transaction.  

  
A Journal cannot be completed unless the total debits entered equal the total credits entered.  

  
1. Select Journal from the Transactions menu - the Journal dialog box displays.  

2. The Reference number defaults to the next available journal number and the Date defaults to 
today's date but can be overridden if required.  

3. Enter a brief description for the journal in Details.  

4. Under the Transaction column select the File Type this journal is being made from.  

5. Under the File column select the file.  

6. Under the Details column select More. 7.   Enter the Debit details.  

  



 

  
  
    

8. Click OK.  

9. Tab to the next line and repeat this process to enter further Debit details as required.  

10. Tab to the next line to enter the Credit details. 11. Tab to the next line and repeat this process to 

enter further Credit details as required.  

  
NOTE A maximum of 100 lines of transaction may be processed on a single journal transaction.  

  

  
  

     



 

BPAY PAYMENTS  
  

A BPAY payment works in a similar way to the Journal. For example, money from the Owner/Property is 

Journalled to the Creditor, then automatically immediately Journalled from the Creditor to the BPAY bank. 
Funds will then sit in the BPAY bank ready for disbursement when desired.  

  
BPAY payments are also the only payments that will automatically create a Pending Payment within the 

same screen if there are insufficient funds. For example, when processing Council Rates using the BPAY 

payments, whilst in the BPAY payment screen you can choose to process multiple payments at a time. For 

Owners that have sufficient funds, the payment will appear in black and funds will be immediately 
Journalled. For Owners that have insufficient funds, the payment will appear in red, to indicate that that 

singular payment will be automatically created as a BPAY pending payment.  

  

1. To create a BPAY payment, select BPAY from the payments type dropdown list  

  

  
  

    

2. A pop up will appear advising that any BPAY transaction with insufficient funds will be highlighted in 

red and automatically created as pending BPAY payments. If there is sufficient funds a payment will 
be journalled immediately. Click OK to continue. If you don’t want to see this message again, select In 

future, do not show this information.  

  



 

  
  

3. Ensure the date is correct  

4. Select the Creditor in the field provided, you can search for the file by selecting the creditor button, 

or begin typing in the field for predictive search to show your entries  

5. Ensure the Creditor you have selected has been setup with a Biller Code (See Setting up Creditors for 
BPay).The Biller Code will then appear alongside the selected Creditor file  

  

  
  

  

  

  

  

6. Select the Transaction Type from the dropdown list. BPay transactions can be processed for Owner, 

Property or Advertising files  

7. Enter the file you wish to make the payment for. If the file has been setup with a BPay Customer 

Reference number for the associated Creditor, the Customer Reference field will be prepopulated  



 

8. If the Property hasn’t been setup with a Customer Reference, you can enter the customer reference 

in the field provided. This will then be stored against the Property for this Creditor for future BPay 

Payments   

9. Enter the details of the payment, the dissection and the amount  

  

  
  

10. Continue the above process for multiple transactions as desired  

Managing Payments  
  

The Payments screen allows you to process and monitor all payments made through Gateway. 

Colour coding allows you to easily identify the status of the payment:  

  
• Light grey indicates the payment has been processed.  

• Red indicates a pending payment where there are insufficient funds to process the 

payment.  

• Black indicates a pending payment where there are sufficient funds to process the 
payment.  A message will display if processing the payment will reduce the funds available 

for withholding money, commission and sundry charges.  

• Blue indicates a pending payment has been entered with a release date.  Gateway will 

remind you if you attempt to process the payment prior to the release date.     Purple 
indicates there are sufficient funds to transfer some but not all of this payment  

  
You may drill down into any of the payments to view the details by double clicking on the item.  

  



 

  
  

  

FILTERING P AYME NTS  
  

The Payments screen displays all payments made through Gateway unless a filter is applied. A filter 

allows you to refine the list of payments displayed by nominating specific details, for example 
display only cheque payments. The view will then only display those payments matching the 

nominated criteria.  

  
1. Select Payments from the Transactions menu - the Payments dialog box displays.  

2. Select Filter from the View menu - the Filter dialog box displays.  

3. The Filter dialog box has two tabs which enable you to set filter options:  

4. Payments - the relevant payment type, for example cheque or journal, and the payment status, 

for example processed or pending. 

  

  



 

  

Advanced - advanced options for filtering the files such as date ranges, nominated 

creditors.  

  

  
  

5. Select the filter options you require and click OK to return to the Payments dialog box. The  

dialog status bar displays the message, Filter Applied.  

  
NOTE If you are unable to see all the payments you would expect in the screen, check the dialog status 
bar. If the message Filter Applied appears the filter needs to be removed. 

REPLACING AN UN-PRESENTED CHEQUE  
  

If a cheque is lost or destroyed, and needs to be re-issued, the following method may be utilised 

instead of reversing the transaction.  

  
1. Select Reconciliation Wizard from the Transactions menu.  

2. Click Advanced Reconciliation.  

3. Click the Cheques tab. 4.   Highlight the cheque you need to replace and select Replace from the 
Edit menu.  

  



 

  
  

5. Enter the new cheque reference number for the replacement cheque and click OK.  

6. Enter a reason for the replacement in comment and click OK.  

7. The old cheque number now appears on your Presented Cheque list and the new cheque number 

appears as un-presented.  

  
NOTE Only un-presented cheques created by a cheque payment transaction may be replaced. 

REVERSING A CHEQUE  
  

If there is a problem with a Cheque transaction it may be reversed.  

  
Note This only applies to cheques generated via Payment, Cheque. Cheques created during the 
disbursement process may not be reversed.  

  
There are several methods for locating the cheque transaction. Search in the Transactions View by Cheque 

number; or in the recipient’s file (Owner, Creditor, Tenant, Sale).  

  
1. Open the file.  

2. Select the Transactions Tab.  

3. Double click on the Cheque transaction to open. 4.   Select the Reverse button.  

  



 

  
Alternatively:  

  
5. Select Reverse > Cheque from the Transactions menu.  

6. Enter the cheque number or reference in Search for the word(s) (or leave the field blank to 

search for all transactions) and click Find Now - all transactions matching the text entered will 

display in the bottom block.  

7. Select the transaction you require and click OK - the (Reverse) Cheque dialog box displays.  

8. Click Reverse - the Reverse Cheque dialog box displays. 9.   Enter details for the reverse cheque 

and click OK.  

  
NOTE It is important for audit requirements that you enter the exact details as to why the reversal is 
necessary. 

CANCELLING A CHEQUE  
  

There may be instances when you need to cancel a cheque number that will never be issued, 

for example if you spilt coffee on the Cheque book and cannot use the next couple of cheques. 

Select Cancel > Cheque from the Transactions menu - the  

Cheque Cancel dialog box displays.  

1.   The next available cheque number defaults in Reference and Date defaults to today's date. 2.   

Enter a brief description as to why you need to cancel the cheque in Reason and click OK.  

  



 

  
  

  

  

  

    
REVERSING A BPAY TRANSACTION  
  

If you have made an error when creating a BPay transaction, it can be reversed   

  

1. To reverse an incorrect payment, open the Owner or Creditor file to view the transaction  

2. Under the Transaction tab, double click on the transaction to open the receipt you wish to reverse  

  

  
  



 

3. The receipt will appear as a Journal where the money has gone from the Property to the Creditor, 

then from the Creditor to the BPay Bank ready for disbursement  

  

  
  

  

  

4. To reverse the transaction, select the Reverse button and enter the reason for the reversal  

5. You will be prompted to close the Owner or Creditor file before processing the reversal, select Yes to 

proceed  

  

  
  

6. Enter the reversal Reason  

  

  



 

  

7. Choose OK  

8. The funds will then be reversed back into the Owners balances  

    

REVERSING A BPAY DISBURSEMENT  
  

If you have made an error with a payment but selected to disburse the BPay bank, settlements can be 

reversed  

  

NOTE: Before reversing a settlement, ensure the payment hasn’t been debited from your bank 
account. If the payment has been made from your bank and you choose to reverse the Settlement 
transaction, issues with your Reconciliation and Auditing can occur  

  

1. Open the BPay Bank file   

2. Select the Transactions Tab  

  

  
  

3. If the BPay bank has been disbursed, there will be a transaction line with the details Settlement.   

4. Double click on the Settlement transaction you wish to reverse.   

    



 

  
  

6. Select the Reverse button, then enter the reason for the reversal  

  

  
  

7. Once done click OK  

8. The funds will then be back into the BPay Bank file  

9. You can then continue to reverse individual payments as required then reprocess where necessary  

Payment Wizard  
  

The Payment Wizard is designed to process multiple payments, where the dollar amount of each 

transaction is identical and the recipient creditor is the same. Examples of this would be Financial 
Year Statement Fees, Landlord Insurance Renewal or Smoke Alarm Servicing.  

  
The wizard also allows you to choose whether or not to create a pending 

payment for any journal amounts that cannot be processed due to insufficient 

funds.  



 

  
You may choose to process the payments as a:  

  
• Cheque payment - allows you to print out or manually draw a 

cheque immediately to make the payment  

• Journal payment - allows you to transfer funds into the creditor 

account from where the funds may be drawn at any time     

Pending payment - allows you to create a pending payment  

  
Payment profiles are saved and may be re-used as required.  

  

  

USING THE PAYME NT WI ZARD  
  

1. Select Payment Wizard from the Transactions menu.  

  

  
  

2. Click Next to select a profile or Create a new profile.  

3. If creating a new profile enter a profile name. 

  



 

  
  

4. Click Next to select a payment method. 5.   Select Cheque, Journal or Pending and click Next.  

  

  
  

6. The cheque or journal number will default to the next available but may be changed if required.  

7. Click Next. If you are using an existing profile the payment details will display, otherwise select 
new to create new payment details.  

  

  
  

8. To create a new payment item Click New. 

9. Enter the value to be paid by each property in Amount.  

10. Select including GST if required.  

11. Enter a brief generic description in Details.  



 

12. Click Creditor to search for and select a creditor.  

13. The default dissection for the selected creditor will appear. If required change the Dissection.  

14. Select Deduct maintenance commission if applicable. 15. Click Save.  

  
NOTE To change an existing payment item select the item and click Open, then update 
the details as required and click Save. To delete an item select it and click Delete.  

  

  
  

16. Click Next.  

17. Select Create pending payments if you want to allow pending payments to be created 

should there be insufficient funds in the particular file.  

18. Click Next. 19. Select each property to be included in the payment.  

  
NOTE The easiest way to identify a group of properties to apply payments to, is by using 
Categories. 

  



 

  
  

20. Click Next.  

21. Click Finish to process the payment. A summary of the Payment Wizard instructions will 

display - you can use the scroll bar on the right-hand side of the screen to view the text if 
required. The wizard will tell you when the process has successfully completed. 22. Click 

Close to exit the Payment Wizard.  

  

  


